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ABSTRACT
Quantifying Parkinson’s Disease Symptoms Using Mobile Devices
Charles Aylward

Current assessments for evaluating the progression of Parkinson’s Disease are largely
qualitative and based on small sets of data obtained from occasional doctor-patient interactions.
There is a clinical need to improve the techniques used for mitigating common Parkinson’s
Disease symptoms. Available data sets for researching the disease are minimal, hindering
advancement toward understanding the underlying causes and effectiveness of treatment and
therapies. Mobile devices present an opportunity to continuously monitor Parkinson’s Disease
patients and collect important information regarding the severity of symptoms. The evolution of
digital technology has opened doors for clinical research to extend beyond the clinic by
incorporating complex sensors in commonly used devices. Leveraging these sensors to quantify
characteristic Parkinson’s Disease symptoms may drastically improve patient care and the
reliability of symptom assessment.

The goal of this project is to design and develop a system for measuring and analyzing
the cardinal symptoms of Parkinson’s using mobile devices. An application for the iPhone and
Apple Watch is developed, utilizing the sensors on the devices to collect data during the
performance of motor tasks. Assessments for tremor, bradykinesia, and postural instability are
implemented to mimic UPDRS evaluations normally performed by a neurologist. The application
connects to a cloud-based server to transfer the collected data for remote access and analysis.
Example MatLab analysis demonstrates potential approaches for extracting meaningful data to be
used for monitoring the progression of Parkinson’s Disease and the effectiveness of treatment and
therapies. High-level verification testing is performed to show general efficacy of the assessment
tasks. The system design successfully lays the groundwork for a mobile device-based assessment

tool to objectively measure Parkinson’s Disease symptoms.
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CHAPTER 1

BACKGROUND

1.1 INTRODUCTION

Parkinson’s disease (PD) is a progressive neurodegenerative disorder characterized by the
manifestation of motor and non-motor dysfunction [1]. While research has shown the disease
results from a complicated interplay of genetic and environmental factors, the cause of the disease
remains unknown [2]. Further complexity arises from clinical challenges with the disease,
including difficulty in making a definitive diagnosis at the early stages and management of
symptoms at later stages [2]. The disease is assessed based on clinical criteria with no universally
established test dictating proper evaluation [1]. A number of rating scales are used to measure
motor impairment, but most of them have not been fully evaluated for validity and reliability [1].
Current treatments reduce symptoms but do not slow the neurodegenerative behavior of the

disease.

1.2 HISTORY

In 1817, James Parkinson published “An Essay on the Shaking Palsy” in which he
describes six cases of people with a condition Parkinson called paralysis agitans, or shaking
palsy. He details the progression of disability characterized by increasing tremor severity,
deteriorating muscle strength, and hunched over posture in his publication:

Involuntary tremulous motion, with lessened muscular power, in parts not in action and

even when supported; with a propensity to bend the trunk forward, and to pass from a
walking to a running pace: the senses and intellects being uninjured.'

! James Parkinson, An Essay on the Shaking Palsy




Parkinson notably distinguishes the tremor symptoms he observed from tremors experienced in
cases of epilepsy, alcoholism, or stroke. He observed gradual onset of the symptoms with motor
impairment beginning in the limbs before moving to the rest of the body. Parkinson concluded
from the symptoms he observed that paralysis agitans, as he labelled the syndrome, resulted from
lesions in the cervical spinal cord but failed to find evidence in post-mortem studies. Four
decades later, French doctor Jean-Martin Charcot, known as “the father of clinical neurology”,
added symptoms to the syndrome and labelled it Parkinson’s Disease to honor the work of James

Parkinson.

1.3 CARDINAL FEATURES

There are four cardinal features of PD often described using the abbreviation TRAP:
tremor, rigidity, akinesia (or bradykinesia), and postural instability [3]. Motor symptoms usually
begin gradually and worsen over time, creating difficulties in walking, talking, and other simple
tasks. While motor symptoms are often used to gauge the severity of the disease, non-motor
symptoms are also impacted. Non-motor symptoms may include mental and behavioral changes,

sleep problems, depression, memory loss, and fatigue [4].

1.3.1 Causes of PD

A combination of environmental and genetic factors is believed to cause the
neurodegeneration associated with PD [20]. Scientists have identified several genetic mutations
linked to PD, most notably the alpha-synuclein gene [4]. While researchers recognize genetic
factors are closely tied to PD, most believe environmental exposures increase a person’s risk of
developing the disease [4]. The same genes and proteins that are altered in inherited cases may
also be altered in sporadic cases resulting from toxins or other factors [4]. PD symptoms begin to

arise following the gradual death of nerve cells in a small portion of the lower brain called the



substantia nigra [11]. These cells normally connect to the striatum in the brain’s basal ganglia
under the cerebral cortex and release the neurotransmitter dopamine to produce smooth,
purposeful movement [4, 11]. Insufficient dopamine in this circuit results in abnormal nerve-
firing patterns causing impaired movement [4]. The cardinal motor impairments associated with

PD manifest when roughly 80% of dopamine has been depleted from the basal ganglia [3, 11].

1.3.2 Tremor

Tremor, or shaking, is often the first symptom of affected patients and is the most
common and easily recognizable among those impacted by the disease. Tremor usually begins in
the arm or hand and progresses to other parts of the body, though not typically to the same extent
as the initial location [5]. In some cases, tremor may only affect one side of the body and may
also affect the chin, tongue, and lips [5]. Tremor motor symptoms are not unique to Parkinson’s
Disease. Another condition often confused with Parkinsonian tremor is Essential Tremor, which
induces similar dysfunction but subtle differences make it distinguishable from PD. Essential
Tremor symptoms increase with motion and are more symmetric than seen in PD patients [21].
Essential Tremor patients do not respond to PD medications making it clear the symptoms do not
share a root cause [21]. Parkinsonian tremor has an oscillation frequency of 4-6Hz at the distal
end of the affected limb and occurs with a supination-pronation motion, also referred to as “pill
rolling” [1]. Parkinsonian tremor is most present at rest and usually decreases with motion,
mental concentration, and during sleep [1]. Some PD patients have also reported an “internal”
shaking not associated with visible tremor [1]. PD patients may also experience a postural tremor,
known as “re-emergent tremor”, identified by outstretching the arms in a horizontal plane [3].
The term “re-emergent” refers to the delay of one to several seconds for the tremor to occur after
extending the arms [42]. Postural tremor and resting tremor occur at the same frequency and are

reduced by the same therapy, indicating a shared root cause. PD patients may also experience



tremor during voluntary movement, known as kinetic tremor, which is often assessed during a
writing task or finger-to-nose motion [42]. Tremors symptoms are not present among all PD

patients and severity fluctuates as the disease progresses [1].

1.3.3 Rigidity

Rigidity associated with PD is characterized by uniform resistance to movement present
in both agonist and antagonist muscles recruited for the movement [3]. Increased stiffness can
affect the neck, shoulders, hips, trunk, ankles and wrists [3]. Normal muscle control involves a
relaxed state at rest, and a flexed state when moved. In Parkinsonian rigidity, the affected muscles
are constantly flexed, often leading to a decreased range of motion [3]. The presence of rigidity is
commonly identified while the affected person is walking with little to no swing of the arms [6].
A neurologist often identifies the symptom by moving the patient’s arm and observing a ratchet-
like motion with short, jerky movement referred to as the “cogwheel phenomenon” [3]. Pain is
often associated with rigidity in PD patients, commonly misdiagnosed as other forms of
rheumatology or skeletomuscular injury [3]. Postural deformities may arise from rigidity
symptoms among PD patients [3]. Some cases of axial postures (i.e. scoliosis or anterocollis)

have manifested through rigidity in the neck and trunk late in the disease [3].

1.3.4 Akinesia and Bradykinesia

Often considered the most debilitating symptom of PD is a general lack or slowness of
voluntary movement [23]. Akinesia specifically refers to a slowness or inability in the initiation
of movement while bradykinesia refers to a slowness in the execution of movement [23].
Bradykinesia is the most characteristic motor symptom of Parkinson’s Disease and encompasses
difficulties in planning, initiating, and executing movement [1]. Bradykinesia causes difficulty in

performing repetitive movements, such as finger tapping, and simultaneous movement [4]. An



inability to perform simple tasks due to bradykinesia creates frustration among PD patients as
activities once performed quickly and easily, such as getting dressed or washing the dishes, may
take several hours [4]. bradykinesia may cause other discomforts including impaired swallowing,
impaired speech, loss of facial expression, and decreased blinking [3]. With its many secondary
symptoms, bradykinesia is often regarded as the most debilitating of the PD symptoms [3].
Assessment of bradykinesia symptoms usually involves observing cadence and amplitude while
the patient performs rapid, repetitive, alternating movements such as finger tapping, heel tapping,

hand gripping, and hand pronation-supination [1].

1.3.5 Postural Instability

Toward the late stages of the disease, following the onset of other clinical features,
patients begin to experience postural instability and a loss of postural reflexes [3]. Postural
instability refers to an instability while standing upright and a loss of reflexes to maintain an
upright posture, often leading to balance issues [6]. The primary danger PD patients face due to
postural instability is retropulsion, or a tendency to fall backward, leading to a predisposition to
hip fractures [6]. Doctors test this using a “pull test”, in which the patient is pulled backward
from the shoulders and their recovery is observed [6]. A normal recovery involves a quick step
backwards to prevent falling, while those affected by postural instability would tumble backwards

without assistance from the doctor [6].

1.3.6 Non-motor Symptoms

The onset of non-motor symptoms may identify PD in some patients. Autonomic
dysfunction, while more typically associated with other neurological disorders, affects many PD
patients [1]. Examples include orthostatic hypotension, sweating dysfunction, sphincter

dysfunction and erectile dysfunction [1]. PD patients may also experience cognitive and

5



neurobehavioral abnormalities with an increased risk for dementia, depression, apathy, anxiety,
and hallucinations [1]. Other non-motor symptoms include sensory abnormalities and sleep
disorders [1]. Measurement of non-motor symptoms provides insight on disease severity and is an

ongoing research area for PD evaluation [22].

1.4 EVALUATION

Several assessments are used to evaluate the symptoms and severity of Parkinson’s
Disease with ranging focuses reflecting functional fluctuations and general level of function [3].
The need for a metric to assess the effectiveness of therapeutic intervention was a driving force
for creating rating scales [3]. As the disease progresses during treatment, evaluations can
determine whether or not the treatment is effective. Often during the course of treatment, patients
experience what doctors refer to as an ON/OFF phenomenon. Patients are considered ON when
medication is working and OFF when the benefit subsides [3]. The patient’s ability to perform
tasks can change dramatically between states, so far as being able to run across the room versus

an inability to rise from a chair [3]. The following sections detail evaluation techniques used.

1.4.1 Hoehn and Yahr

In 1967, Melvin Yahr and Margaret Hoehn published a system for evaluating the
progression of Parkinson’s Disease in the journal Neurology [8]. The Hoehn and Yahr (HY)
system utilizes 5 stages to describe and classify the severity of motor symptoms [8]. The system
has since been modified to include steps 1.5 and 2.5 to account for intermediate stages [8]. The
HY scale provides a simple method to categorize the severity of the disease to reflect the degree
of progression [8]. However, the scale is not linear, and the ranking of stages does not always
reflect progression as expected; in some cases, patients have more difficulty performing the stage

2 assessment tasks than those in stage 3 [8]. The advantages of this scale are its popularity and



simplicity to carry out. However, the categorical scale and inaccurate rank-progression
correlation has led the scale to be largely supplanted by the Unified Parkinson’s Disease Rating

Scale [8]. The HY scale is shown in Table 1.

Table 1. Modified Hoehn and Yahr scale [8]

1.0 Unilateral involvement only

1.5 Unilateral and axial involvement

2.0 Bilateral involvement without impairment of balance

2.5 Mild bilateral disease with recover on pull test

3.0 Mild to moderate bilateral disease; some postural instability, physically independent
4.0 Severe disability; still able to walk or stand unassisted

5.0 Wheelchair bound or bedridden unless aided

1.4.2 Schwab and England Activities of Daily Living

Developed by R. S. Schwab and A. C. England Jr., the Schwab and England activities of
daily living (ADL) rating scale is frequently used to provide an estimate of severity based on the
patient’s ability to perform common tasks [7]. The examination involves an interview with the
patient and often includes a collateral source, such as a spouse [7]. The examiner will ask about
the patient’s ability to perform common household chores and whether assistance is needed. The
scale uses percentages to rank severity with 5% increments between 0%-100% [7]. Table 2 shows

the sections of the Schwab and England ADL assessment.



Table 2. Schwab and England ADL scale [7]

100% | Completely independent. Able to do all chores without slowness, difficulty or impairment.

Essentially normal. Unaware of any difficulty.

90% | Completely independent. Able to do all chores with some degree of slowness, difficulty and
impairment. Might take twice as long. Beginning to be aware of difficulty.

80% | Completely independent in most chores. Takes twice as long. Conscious of difficulty and
slowness

70% | Not completely independent. More difficulty with some chores. Three to four times as long in
some. Must spend a large part of the day with chores.

60% | Some dependency. Can do most chores, but exceedingly slowly and with much effort. Errors;
some impossible.

50% | More dependent. Help with half, slower, etc. Difficulty with everything.

40% | Very dependent. Can assist with all chores, but few alone.

30% | With effort, now and then does a few chores alone or begins alone. Much help needed

20% | Nothing alone. Can be a slight help with some chores. Severe invalid.

10% | Totally dependent, helpless. Complete invalid.

0% Vegetative functions such as swallowing, bladder and bowel functions are not functioning.

Bedridden.

1.4.3 Unified Parkinson’s Disease Rating Scale (UPDRS)

The global “gold standard” rating scale for PD assessment is the Unified
Parkinson’s Disease Rating Scale (UPDRS), owned and licensed by the International Parkinson
and Movement Disorder Society [7]. The UPDRS was developed in an effort to incorporate
elements from existing scales into a single comprehensive assessment [24]. However, the UPDRS
has important limitations and has undergone several revisions since its development [7].
In 1987, the official UPDRS was published by Stanley Fahn and the UPDRS Development
Committee. The UPDRS includes four subscales covering behavioral features, activities of daily

living, motor symptom ratings, and therapeutic complications [7]. Part I of the UPDRS covers




mentation, behavior, and mood and examines for intellectual impairments, thought disorders,
depression, and changes in motivation [25]. Part II includes a 13 items that directly relate to daily
activities such as dressing and eating while also examining patient perceptions of primary disease
manifestations like tremor and salivation [24, 25]. Part III evaluates motor impairment including
speech, facial expression, rest and postural tremor, rigidity, bradykinesia, posture, gait, and
postural stability [25].

In 2001, the International Movement Disorder Society (MDS) created a UPDRS task
force with three main objectives: critique existing scales, identify clinical areas that are not
adequately rated, and make recommendations on maintaining or modifying currently available
scales [24]. The task force unanimously considered the concept of a single clinical rating scale to
be an important tool for clear and consistent communication among movement disorder
colleagues [24]. In 2003, the conclusions of the task force were published. They agreed the
UPDRS has many strengths and provides an effective comprehensive assessment of motor
symptoms associated with PD [24]. However, the weaknesses were substantial in the assessment
of non-motor symptoms, leading the task force to develop a list of recommended improvements
[25]. In 2008, based on the recommendations laid out by the task force, the MDS published an
MDS-sponsored revision of the UPDRS (MDS-UPDRS) [26]. The four component design was
retained with a shifted focus for each of the sections [26]. Part I of the MDS-UPDRS concerns
“non-motor experiences of daily living”, Part Il concerns “motor experiences of daily living”,
Part III remains focused on motor symptom examination, and Part IV concerns “motor
complications” [26]. In practice, the UPDRS test is combined with the HY and the Schwan and
England ADL assessments [27]. Details for each part of the MDS-UPDRS assessment are shown

in Table 3.



Table 3. MDS-UPDRS sections [26]

Part I: Nonmotor Aspects of Experiences of Daily Living

1.1 Cognitive impairment

1.2 Hallucinations and psychosis

1.3 Depressed mood

1.4 Anxious mood

1.5 Apathy Features of dopamine dysregulation syndrome

1.6 Sleep problems

1.7 Daytime sleepiness

1.8 Pain and other sensations

1.9 Urinary problems

1.10 Constipation problems

1.11 Lightheadedness on standing

1.12 Fatigue

Part II: Motor Experiences of Daily Living

2.1 Speech

2.2 Saliva and drooling

2.3 Chewing and swallowing

2.4 Eating tasks

2.5 Dressing

2.6 Hygiene

2.7 Handwriting

2.8 Doing hobbies and other activities

2.9 Turning in bed

2.10 Tremor impact on activities

2.11 Getting in and out of bed

2.12 Walking and balance

2.13 Freezing

Part I1I: Motor Examination

3.1 Speech

3.2 Facial expression

3.3 Rigidity

3.4 Finger tapping

3.5 Hand movements

3.6 Pronation—supination movements of hands

3.7 Toe tapping

3.8 Leg agility

3.9 Arising from chair

3.10 Gait

3.11 Freezing of gait

3.12 Postural stability

3.13 Posture

3.14 Global spontaneity of movement (body bradykinesia)

3.15 Postural tremor of hands

3.16 Kinetic tremor of hands

3.17 Rest tremor amplitude

3.18 Constancy of rest tremor

Part IV: Motor Complications

4.1 Dyskinesias: time spent with dyskinesias

4.2 Dyskinesias: functional impact of dyskinesias

4.3 Dyskinesias: painful off state dystonia

4.4 Motor fluctuations: time spent in the off state

4.5 Motor fluctuations: functional impact of fluctuations

4.6 Motor fluctuations: complexity of motor fluctuations
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1.5 PATIENT POPULATION

Parkinson’s Disease is one of the most common neurological disorders with an estimated
one in every 1,000 people affected by the condition [10]. A widely accepted figure for the
approximate prevalence of PD globally is 200 for every 100,000 individuals [10]. In the U.S., an
estimated 750,000 to 1.5 million individuals are affected [10]. In the U.K., there are 120,000 to
130,000 diagnosed individuals, but many more are affected that remain undiagnosed [10]. Men
are 1.5 times more likely to than women to develop the condition and symptoms generally surface
at age 60 [10]. The risk increases to one in 100 for those aged between 60 and 80 years of age,
and one in 50 at age 80 [9]. There have been cases of the disorder in individuals under the age of
20, known as juvenile parkinsonism [9]. While the disease prevalence is skewed toward later
ages and occurs more frequently in men, there is no boundary in age, race, or gender [9]. A study
by Hoehn and Yahr in 1967 observed mortality rates related to the condition. They found 61% of
patients were dead or severely disabled 5-9 years after diagnosis, increasing to 80% after 10 years
[10]. This rate has since been reduced with the advent of treatments such as Levodopa, a mainstay
pharmacological treatment to supplement the loss of dopamine with PD, making it possible for

PD patients to live out a normal length life [10, 11].

1.6 TREATMENTS

There is currently no cure for PD, but symptoms can be relieved with surgeries or
medication [28]. The primary objective of medical management is to maximize control over the
target signs and symptoms by selecting the appropriate drug, dosage, and frequency [25].
Symptoms and response to medication are highly variable from patient to patient and require a
very individualized approach [25]. Drug therapies target motor symptoms by increasing
dopamine levels in the brain or targeting neurotransmitters in the body and non-motor therapies

focus on symptoms like depression [28]. The mainstay drug is levodopa (L-dopa) which provides
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a dopamine precursor to nerve cells helping to replenish the brain’s reduced supply of dopamine
[23]. Patients cannot simply take a dopamine pill because dopamine does not easily pass through
the blood-brain barrier, a protective lining of cells inside blood vessels that regulate the transport
of nutrients and substances in the brain [23]. Levodopa has a high rate of success with reducing or
eliminating motor symptoms during the early stages of PD, allowing a majority of patients to
extend the period in which they can lead active, productive lives [23].

When drug therapies are no longer sufficient, surgical approaches are used to relieve
symptoms [23]. The earliest types of surgical techniques involved selectively destroying specific
parts of the brain that contribute to symptoms [23]. These risky techniques have been largely
replaced by deep brain stimulation (DBS), a technique in which an electrode is implanted into
part of the brain and connected to a pulse generator implanted in the chest area [23]. When turned
on, the pulse generator and electrode stimulate the brain painlessly to block signals that cause
many of the motor symptoms of PD [23]. DBS is generally appropriate for patients who have
levodopa-responsive PD and do not have memory problems, hallucinations, or severe depression
[23]. As with any brain surgery, DBS surgery has potential complications like stroke or brain

hemorrhage [23].

1.7 NEED FOR RESEARCH

Recent developments in Parkinson’s Disease research are giving researchers optimism
that the disease can be defeated. PD is a complex neurodegenerative disease resulting from the
death of dopamine producing cells in the substantia nigra [11]. What triggers the death of these
cells remains unknown [11]. Studying genetics, epidemiology, and environmental factors all
contribute to finding a cure. Identifying genes linked to PD fuels growth in understanding the
disease process, revealing drug targets, improving early diagnosis, and developing animal models

to mimic the nerve death in humans [11]. The National Institute of Health (NIH) released a
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formal Parkinson’s Disease research agenda in 2000 stating that new technologies and discoveries
in neuroscience are opening new doors to potential cures [11]. Halting the progression of PD,
restoring lost function and even preventing the disease are becoming more realistic possibilities
through advances in neuroimaging, gene array technologies, animal models, biomarkers and other
modern scientific tools [11]. The National Institute of Neurological Disorders and Stroke
(NINDS) is currently leading an initiative to better understand and diagnose PD, develop new
treatments, and ultimately prevent PD [29]. In 2014, the NNIDS held a conference, labelled
“PD2014”, bringing neuroscientists, physicians, public and private organization representatives,
and PD patients together to develop a set of recommendations addressing the highest priorities for
advancing research on PD [29]. In the topic of clinical research, one of the recommendations
involves the use of “innovative outcome measures to evaluate motor and non-motor features,
including patient- and clinician- reported outcomes that leverage emerging information
technology (IT) opportunities, enhance sensitivity and specificity of measurement, and facilitate
long-term follow-up of well-characterized cohorts” [30]. One of the approaches to address this
research is an investigation of the feasibility and validity of “diverse methods of data collection
including computerized tablet, smartphone, remote monitoring, and computerized adaptive

testing” [30].

1.8 MOBILE TECHNOLOGY

Difficulties remain in the reliability of clinically evaluated PD symptoms involving
functioning in everyday life, long periods of time, and observing critical milestones throughout
the course of the disease [12]. Fluctuating events like responses to medicine and incidents like
falling are difficult for doctors to track and react to without constant monitoring. The evolving
miniaturization, sophistication, proliferation, and accessibility of sensing technologies opens a

new door to data collection beyond the doctor’s office by introducing novel methods for patient
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monitoring [12]. Modern sensors embedded in every day devices can track and send important
health information like motion, sleep patterns and heart rate to health professionals within
minutes [12]. This can enhance treatment methods, preventative care, and drastically reduce the
number of trips taken to the doctor’s office. With the rapid growth of these new technologies, the
questions now faced are how to properly deploy them, what are the clinical needs, and how to
leverage them to replace or enhance current clinical assessment tools. The ability to remotely
capture symptom data and use it to optimize treatment strategies introduces a possibility to create
closed loop treatment systems while producing valuable information for research [12]. For
example, a wearable system may detect a change in step cadence associated with stride length,
triggering a device designed to deliver proprioceptive cues for changing postural control and
stepping pattern which could in turn prevent a fall [12]. Continuously monitoring PD symptoms
may also be used to track and optimize the effectiveness of therapies, such as deep brain

stimulation.

1.8.1 Sensor Technology

Modern mobile devices commonly contain sensors for interaction with the device and
installed software applications. Evolving sensor technology has led to decreasing sensor sizes
allowing for several sensors to be embedded in digital devices like smart phones and wearable
technology. Smart devices like mobile phones, tables, and smart watches contain inertial sensors
(accelerometer, gyroscope), GPS, and pedometers with high levels of accuracy for motion
tracking. Other advanced wearable technologies contain sensors for monitoring respiratory rate,
skin conductance, blood pressure, oximetry, and electrocardiography [12]. In addition to the high
level of accuracy and wide range of capabilities, the sensors are low power enabling them to poll
data for long periods of time. For instance, sleep medicine research has begun utilizing actigraphy

(monitoring human rest/activity cycles) to supplant traditional methods like polysomnography
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due to its validity, low cost, and ability to monitor patients at home [12]. Accelerometers and
gyroscopes are well suited for the detection of PD motor symptoms such as tremor, bradykinesia,

gait impairment, and motor complications, such as dyskinesia [12].

1.8.2 Big Data Collection

The health care industry generates large amounts of data, primarily due to regulatory
requirements, record keeping, and patient care [16] and biomedical research data is stored in
varying formats, increasing the need to organize and understand the data to foster new discovery
[31]. While most health care data are stored in hard copy form, the current trend is toward rapid
digitization [16]. By definition, big data in health care refers to health data sets so large and
complex that traditional data management tools and methods cannot easily manage the data,
overwhelmed by the volume and diversity of data types [16]. However, recent technological
advances are improving on the compilation, storage, and secured sharing of big data [32]. For
instance, electronic medical record (EMR) systems are becoming more affordable and allow data
to be exchanged more easily [32]. In 2014, the NIH published a Big Data to Knowledge (BD2K)
initiative to maximize the use of big data in health care by defining how to extract value from
data and create analytic tools needed to enhance the utility of the data [31]. A recommended
approach from the NINDS PD2014 conference for progressing clinical research in PD is to
“develop improved informatics capability to include investigation of how ‘big data’ may
contribute to a fuller understanding of PD, a central repository for PD trial data, [and] a resource
for trial design simulations™ [30]. The medical experts and PD patients in attendance noted that
making use of existing data sets is an efficient way to address questions related to the
characterization of PD symptoms and progression [30]. They stressed the importance for a central
body to manage the standardization of datasets, uniformly archive existing data, and provide a

user-friendly end product [30]. Development of an information system for health data must
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overcome barriers to use including access to data, ethical challenges, and de-identification of data
[30]. Implementing data security measures to protect sensitive patient information is important to
comply with HIPAA regulations. Many private-sector companies are developing applications and
analytical tools that help patients, physicians, and other health care stakeholders identify value
and opportunities with big data [32]. An evaluation of the marketplace in 2013 revealed over 200
businesses created since 2010 are developing such tools to make better use of available health
information [32]. Many research groups are in the process of assessing methods to probe
individual motor and non-motor symptoms [12]. An opportunity exists to identify technologies
and approaches with the most versatility, greatest ease of deployment, least patient and physician
encumbrance, and lowest cost [12]. Choosing a platform for technology-based objective
measurements (TOM) behind which developers and end-users can coalesce is key for developing

applications for big data collection and analysis [12].

1.9 RELATED WORK

The evolution of digital technology has resulted in a surging interdisciplinary effort to
explore novel applications in medical research. Researchers from electrical, computer,
mechanical and biomedical backgrounds are working cohesively to design, build, and test
systems intended to meet an abundance of clinical needs. The need for enhancing assessment
tools for Parkinson’s Disease is no exception. Within the last 5 years, several methods have been
proposed by researchers around the world to enhance PD research efforts by utilizing mobile
technology and small sensors. The following examples demonstrate recent developments but only

provide a small snippet of the many global research efforts.

1.9.1 mPower
In 2015, Sage Bionetworks launched an observational study using Apple’s ResearchKit

library on iPhones to evaluate the feasibility of remotely collecting frequent information about
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PD symptom severity on a daily basis [37]. Since the release of the iPhone application dubbed
“mPower”, over 12,000 participants have enrolled [38]. The study is intended to gather data from
any population, healthy patients and those affected by PD, to create a large database accessible to

researchers interested in the data [37].

1.9.2 Kinesia 360

In January 2016, Great Lakes Neurotechnologies began clinical trials using their Kinesia
360 product, a wearable technology-based device to objectively assess PD symptoms [39]. There
are 45 PD patients enrolled in the clinical trial aimed to investigate the efficacy of the product to
measure symptoms [39]. Kinesia 36 features a mobile app and wireless motion sensors worn on
the wrist and ankle to measure tremor, dykinesias, and mobility during normal daily activities.
The data collected is transferred to a cloud server where data reports are generated for clinician

review [39].

1.9.3 Academic Research

In addition to interested research organizations, quantification of motor symptoms is a
trending topic among academic researchers. A Master’s thesis produced by Michelle Vos at the
University of Twente in the Netherlands involves the use of a glove containing inertial sensors to
quantify tremor, bradykinesia and rigidity in PD patients by observing wrist angle, arm
orientation, and movement [41]. The conclusion of the thesis showed promising results with the
gloves ability to measure bradykinesia and rigidity symptoms [41]. Another study done by
researchers at several universities in China [40] succeeded in creating a wrist worn device with a
finger sensor attachment that has very a high correlation with the UPDRS evaluation performed
by neurologists for bradykinesia tasks. Both studies were published in 2015 from universities in
Europe and Asia, indicating the current global trend toward implementing mobile technology in

medical research.
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CHAPTER 2
OBJECTIVES
Research groups around the world are attempting to tackle the challenge of leveraging
mobile technology to enhance medical care. Difficulties arise when device engineers must take
into consideration regulations not normally seen outside of the medical industry. This requires
engineers and medical professionals working together to build a cohesive system optimized to
meet medical needs and stay within FDA regulations while considering the boundaries of device
capabilities. With the current treatment methods and medical care provided for those with
Parkinson’s Disease, an opportunity exists to harness mobile device technology to provide much
improved care. Sensor technology in common devices found in the everyday pockets of people
across the nation have the potential to provide valuable insight regarding the progression of the

disease and information normally unobtainable for clinicians.

2.1 PROJECT GOAL

The goal of this thesis is to design and develop a working prototype of a mobile
application to be used for measuring the cardinal features of Parkinson’s Disease. The application
should demonstrate the potential for sensors in commonly used consumer electronics to produce
valuable clinical data for evaluating Parkinson’s Disease symptoms outside of a doctor’s office.
By harnessing mobile technology already largely integrated into society, gathering large amounts
of data for improved analysis becomes feasible. The clinical need for a quantitative assessment of
PD motor symptom progression is clear. Designing a system to address this need and accomplish
the project goal requires a set of comprehensive functional requirements and system
specifications as listed below.
Functional Requirements

= Record patient information (demographics, PD characteristics, etc.)
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= Provide a means for measuring tremor symptoms

= Provide a means for measuring gait symptoms

= Provide a means for measuring bradykinesia symptoms

= Store data on cloud server

= Perform analysis on measurements

= User friendly interface

= Secure data by requiring authentication to access

= Include a sign up process with eligibility requirements
System Specifications

= i0S/watchOS application

= iPhone 6 (i0S 9.5.3/10)

= Apple Watch (watchOS 2.3.2/3)

= ResearchKit framework

=  Amazon Web Services (AWS) S3 cloud storage

=  Matlab 2015a for analysis

= CoreMotion framework to access hardware (sensors, touch screen)

= CoreData framework for data management and persistence

= SQLite Studio for accessing database file on computer
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CHAPTER 3

DESIGN OVERVIEW

3.1 SYSTEM OVERVIEW

Designing a digital system for clinical purposes requires consideration of the patient,
doctor, and protection of health information. Development of the user interface should ensure
ease of use, especially when considering a target audience that is less adaptive to new technology.
The front-end system design considers usability, aesthetics, and instruction deliverance to assist
in proper use and comfort while using the application. Back-end design focuses on data
persistence, speed, security, and data formatting to ensure the necessary precautions are taken
with the transportation of digital health information while keeping the data in a format readily
used for analysis.

The devices used for development of the application are the iPhone 6 and the Apple
Watch. Selection of the hardware was influenced by ease of integration into St. Jude Medical’s
existing patient care technology, ease of use, and device prevalence among smart device
consumers. The iPhone provides data persistence, sensor recordings, and central processing while

the Apple Watch provides a secondary wearable source for sensor recordings.

#2--F

Figure 1. High level system overview
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Figure 1 shows the overview of system operation from the user at home with the Apple Watch
and iPhone to collect data related to PD symptoms, uploading the data to a cloud database server,
and the downloading of data by doctors and clinicians for analysis. The Apple Watch is worn by
the user to collect motion data from the arm and transfers that data to the iPhone via Bluetooth.
The iPhone provides both data collection and data management by uploading the collected data to
a secure cloud server via an internet connection through WiFi or mobile broadband. Once
uploaded, the data may be downloaded by an authenticated user, typically a clinician or doctor,

and manipulated using data analysis tools to extract valuable parameters.

3.1.1 Design Workflow

The design workflow centers around the flow of data, beginning with collection from the
patient and ending with deliverance to the doctor, clinic, or data analyzer. Initial steps of data
collection involve instructing the user to navigate through the application, starting and stopping
sensor input, and storing sensor output. Deliverance of data involves moving the data from the
local device to a remote location while maintaining data integrity. The application design begins
with creating a user-friendly interface easily understood to new users. Instructions guide the user
through all sections of the application from the signup process to the performance of tasks.
During each task, sensors in the iPhone and Apple Watch are turned on to collect motor-related
symptoms data and store the data locally on the iPhone. Sensory data may be uploaded to an
Amazon Web Services (AWS) server cloud server by pressing an “Upload Data” button easily
found in the application. Once the data has been uploaded to AWS cloud storage, the data may be

accessed by an authenticated user from a computer and downloaded for analysis.
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3.1.2 Sensors

The sensors used in the application focus on collecting motion data related to the
cardinal features of PD. The accelerometer, gyroscope, magnometer, and touch screen sensors are
used during instructed tasks similar to those performed in the UPDRS assessment. The iPhone 6
features a 6-axis gyroscope-accelerometer combo unit, an additional 3-axis accelerometer,
touchscreen controller, magnometer, and GPS. The Apple Watch features a 6-axis gyroscope-
accelerometer combo unit, pressure-sensitive touchscreen controller, and heart rate monitor. A

full list of sensors found in the Apple Watch and iPhone 6 is shown in Table 4.

Table 4. Sensors in the Apple Watch and iPhone 6

Apple Watch iPhone 6

Accelerometer

Gyroscope

X
X
Microphone X

Sl ltalts

Heart Rate Sensor

GPS

Touch ID (Biometric sensor)

Proximity Sensor (i.e. phone near ear)

Ambient Light Sensor X

Camera/Video Camera

Magnetometer

ittt bl el

Touch Sensor X

The symptoms targeted in this application are primarily motion-based making the motion-related
sensors most useful. The accelerometer and gyroscope of the Apple Watch or iPhone 6 are used
during the gait and tremor tasks. Continuous data samples from these sensors reveal important
information regarding the amplitude and oscillation frequency normally observed visually by a
neurologist while performing a clinical assessment. Figure 2 shows the axes of rotation and
movement for the gyroscope and accelerometer. Oscillation patterns on each axis are recorded to

be analyzed and compared to oscillation frequencies characteristic to PD.
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Figure 2. iPhone axes for the gyroscope and accelerometer [19]

The accelerometer and gyroscope in the Apple Watch and iPhone offer high accuracy and

sensitivity. Apple does not openly release specifications for their devices, leaving it up to reverse-

engineering companies to find out embedded chip specifications used in the devices such as the

accelerometer. Device teardowns performed by iFixit [17] and Chipworks [18] reveal the

accelerometer and gyroscope part numbers used in the devices to learn about the specifications.

The specifications for the accelerometers and gyroscope in the iPhone 6 are listed in Table 5.

Table 5. Accelerometer/Gyroscope specifications for iPhone 6 [36]

Parameter Bosch BMA280 |[InvenSense MPU-6500 |Units
Sensor type lAccelerometer  [Accel/Gyro Combo -
IADC range 14 16 bit
|Acceleration range 2 +4, 48 +16 |2, +4, +£8 +16 I
Maximum sensitivity 4096 16684 LSB/g
Temperature sensitivity 0.015 0.026 %/K
Cross axis sensitivity 1 2 %
INonlinearity 0.5 0.5 %
Output data rate 2000 4000 Hz
Cold start up time 3 30 ms
Sleep mode start up time 1 20 ms
IAccelerometer start up time from sleep mode 1.3 20 ms
|Accelerometer supply current in normal mode 130 450 LA
lAccelerometer supply current in low power mode 1 [6.5 7.27 LA
|Accelerometer supply current in low power mode 2 66 18.65 LA
Sleep mode current 2.1 6 LA
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The iPhone 6 and Apple Watch both feature touch screen displays capable of accurately
measuring tapping motion as related to PD. The iPhone 6 has a capacitive multi-touch touch
screen with excellent touch-display response time. While the touch screen primarily serves as the
navigation utility, it also provides a valuable sensor for recording PD motor symptoms related to
bradykinesia. The 4.7” touch screen on the iPhone 6 is appropriately sized for interaction during
the performance of an activity intended to measure bradykinesia symptoms. Figure 3 shows the

touch screen sensor on the iPhone.

Figure 3. iPhone touch screen sensor [36]

3.1.3 Software

The software used for the application is largely dependent on the hardware. The
application runs on Apple’s iOS mobile device operating system (OS) for the iPhone and the
watchOS software dedicated for the Apple Watch. Apple devices require the use of the
proprietary device OS eliminating the need for a software comparison process. The application
was built for i0S 9.5.3 on the iPhone 6 and watchOS 2.3.2 on the Apple Watch. In order to
maintain compatibility with future iterations of iOS and watchOS, the application has been

converted to provide compatibility for iOS 10 and watchOS 3.0. The cloud storage utilized is the
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AWS Simple Storage Service (S3). Amazon S3 provides easy to use object storage for developers

and offers HIPAA compliance for securely storing protected health information (PHI).

3.2 APPLICATION DESIGN

Development of the application required the use of Apple’s proprietary integrated
development environment (IDE) Xcode compatible only on Mac OS X. In addition to providing
the environment for code editing, Xcode is used for debugging, project file management,
compiling, and version control. Developing code for apple devices requires the use of Apple’s
proprietary coding languages. Objective-C was the standard language used for Apple
development until the release of Swift in 2014. Most long-standing applications seen on Apple
devices are written in Objective-C. Only recently has Swift gained traction with new applications
being written in Swift and old applications beginning to convert. The language used for
development of the application discussed here is Swift with frameworks included in the build
written in Objective-C. The included frameworks provide application program interfaces (API)
enabling the use of hardware and software packages by the application. Accessing sensors, saving
data to local storage, uploading data to cloud servers, and manipulating data formats are all
examples of functions that may be supplemented using an associated framework. The frameworks

used in the application and their corresponding languages are listed in Table 6.

Table 6. Frameworks included in the application

Framework Language
WatchKit Swift

HealthKit Swift

ResearchKit Objective-C
SwiftyJSON Objective-C/Swift
CoreData Swift

CoreMotion Swift

AWS Objective-C/Swift
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In 2015, Apple released ResearchKit, an open source framework intended to provide medical
researchers with a platform to conduct studies using Apple technology [33]. The ResearchKit
framework provides a model for instructing users through various tasks accessing the sensors on
the mobile device, making it a valuable tool for the development of this application. ResearchKit
also works seamlessly with HealthKit, a framework connected to the Health app integrated into
i0S, providing health-related patient data potentially relevant to the medical topic focused on by
a ResearchKit application such as height, weight, age, or skin tone [33].

The WatchKit framework is required for the use of the Apple Watch with an iPhone
application. Currently, standalone Apple Watch applications cannot be developed. Instead, a
watch “extension” application is installed on the Apple Watch “paired” to the iPhone on which
the main application is installed. The WatchKit framework provides functions for initiating and
maintaining communication between the Apple Watch and the iPhone while the application is
open. This is important for relaying sensor information collected on the watch to the iPhone after
completion of the motor tasks performed using the watch.

The CoreMotion framework allows the application to receive motion data from the
hardware and process that data. Pre-defined classes and objects provide the means for pulling the
hardware output into the software for manipulation in the application. CoreMotion restrictions
allows for sampling from the motion sensors at a rate of up to 100Hz.

The CoreData and AWS frameworks are both used for the storage of data. CoreData is
used for local storage on the iPhone where sensor samples are stored after task completion before
uploading to the cloud server. The AWS framework provides the API needed to pass information

stored using CoreData onto the AWS cloud servers.
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3.2.1 Key Components

The user-facing portion of the application consists of 3 key components: tasks, patient
information, and data analysis. Upon opening the application, the user is presented with a
welcome page and the option to sign up to participate in the study affiliated with the application.
After signing up, the user interface (UI) consists of 3 main tabs for each of the 3 components. At
any time, the user may choose to opt out of the study.

The sign up process for the application involves inputting personal information and
health information related to the user’s current PD treatment. An eligibility form is completed to
determine if the user meets the inclusion criteria for participation in the application. The
following criteria must be met to be eligible:

= Over 18 years of age

= Diagnosed with Parkinson’s Disease

= Neurologically stable

= Able to understand the study and informed consent form

= Not participating in a clinical investigation that includes an active arm treatment

= Able to perform the motor tasks required for the study

= Able to use the iPhone and Apple Watch apps.
If the user meets the eligibility criteria, demographic and PD characteristic information is
collected as shown in Figure 4. This data is stored securely and presented to the user on the
profile tab of the UI shown in Figure 5. This provides a visual confirmation for the user to ensure
the information input during the signup process is correct. The profile page also includes a button

for uploading data collected during the tasks to a secure cloud server.
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#0200 Verizon & 7 3 g4y m-

< Back Cancel

Have you been diagnosed with Parkinson's
Disease?

Are you 18 or older?

Are you neurologically stable?
ﬁ

Are you able to understand the study and
informed consent form?

N

Demographic

Please fill out the information below

Age 50
Gender Male

Ethnicity White

Next

#0250 Verizon = 1:21PM 7 3 o4 -

< Done

#0290 Verizon & 1:20 PM 7 3 o4 -

< Cancel

PD Characteristics

Please fill out the information below

Welcome aboard.

o " Thank you for joining this study.
PD Diagnosis Date  12/5/2004

MEDICATIONS TAKEN IN THE LAST 24 HOURS
Carbidopa/Levodopa v
Dopamine agonists

Anticholinergics

MAO-B Inhibitors

COMT Inhibitors

Figure 4. Application signup process

eecco Verizon F

121PM

RE RN

Profile

Test Name

Upload Data

myNeuro Research Study

Age

Gender

Ethnicity
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Medications

DBS Parameter

Backup JSON Files

Backup with DynamaDB
Leave Study

50

Male

White

12/5/04

Carbidopa/Levodopa

100 Hz

41

Figure 5. Profile tab of the application

A list of the available tasks is presented after navigating to the activities tab as seen in

Figure 6. Tasks may be selected by tapping on the respective list button, after which instructions

are presented to guide the user through the completion of the task. Each task takes no longer than

5 minutes to complete with the shortest task taking approximately 10 seconds. Tasks intended to

collect motor symptom related data contain visual instruction steps indicating proper performance

of the selected task. After navigating through the instructional steps, an audible countdown

precedes the initiation of the sensors. The “active step” is the portion of each task dedicated to
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collecting data from the sensors while the user performs an indicated motion. The last step of
each tasks presents a confirmation of completion and allows the user to return back to the main

screen.

®ec00 Verizon = 1:21PM <} 94% m
Activities

Questionnaire
Questionnaire

Tremor
Test Tremor

Bradykinesia
Test Bradykinesia

Gait

Test gait and balance

Tremor (Watch)
Test Tremor (Apple Watch)

Bradykinesia (Watch)
Test Bradykinesia (Apple Watch)

Figure 6. Activities tab of the application

Following completion of each of the motor tasks, the immediate results of low level
analysis are displayed on the analysis tab as shown in Figure 7. Data collected from the sensors is
processed on the iPhone to be translated into an estimated UPDRS score for each task. In order to
estimate the UPDRS score, a correlation between the sensor output and neurologist-based scores
will need to be developed through validation testing. After the data has been processed locally,
the option to upload to the cloud server becomes available via a button on the profile tab. Once
uploaded, the data may be accessed for viewing and further analysis by an authenticated user on a

computer.
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5.1.2 Clinical Trials

With a refined user interface and verified sensor efficacy, a clinical study incorporating
PD patients should be performed to develop algorithms to calculate UPDRS scores relative to
those given by neurologists. A clinical study with PD patients may also provide valuable

feedback regarding the ease of use of the application.

5.1.3 Application Improvements

As research progresses in the use of mobile devices for PD symptom assessment, new
methods may prove to be more effective for providing insight on the progression of the disease.
With this in mind, the application presented here is designed to simplify improvements with
content and methods for data analysis. Three tasks were incorporated in the application to
demonstrate how the sensors in the mobile devices can be utilized to gather motor related
symptom data. This included leveraging the inertial sensors, touch screen, and GPS for tremor,
bradykinesia, and postural stability assessment. Other sensors and additional tasks may be
seamlessly integrated due to the modular design of the application. For example, to provide
insight on vocal symptoms characteristic to PD, a new task may direct the user to speak into the

microphone to gather voice data to be analyzed.
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1.0 GENERAL INFORMATION
1.1 Introduction

The myNeuro application is intended for use in a clinical environment by Parkinson’s Disease
patients under the supervision of a neurologist. The application is not intended to provide
diagnostic information. Data gathered by the application is intended for research purposes only.

1.2 Requirements

Hardware Requirements:
- iPod Touch 5/iPhone 5 or greater
- Apple computer (MacBook Pro, MacBook Air, iMac, etc.)
- Apple Watch (optional)
Software Requirements:
- Xcode 7.3.1 or greater
- 108 9.3.5 or greater
- watchOS 2.2.2 or greater
- OS X 10.11.6 or greater
Other Requirements:
- Apple developer’s license
- Amazon Web Services (AWS) account

1.3 Eligibility
The myNeuro app is only intended for use with users who meet the following inclusion criteria:

- Over 18 years of age

- Diagnosed with Parkinson’s Disease

- Neurologically stable

- Able to understand the study and informed consent form

- Not participating in a clinical investigation that includes an active arm treatment
- Able to perform the motor tasks required for the study

- Able to use the iPhone and Apple Watch apps
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2.0 INSTALLATION
2.1 Installing the App

The myNeuro application is currently in a development phase and is not available to consumers
on the App Store. A development version of the app can be installed on a compatible device using
Xcode on an Apple computer. There are 2 methods to install the app:

Method 1: Build the app and install

1. Download the source code for the application here.

2. After downloading, unzip the archive and open the “.xcodeproj” file in Xcode.

3. Inthe Xcode top menu bar, go to Xcode > Preferences and navigate to the Accounts
Tab. Add your Apple ID by clicking the plus sign in the lower left corner and choose
“Add Apple ID...” and login to your account.

4. With the myNeuro project file selected in the left pane, select each of the Targets
(myNeuro, neuroWatch, neuroWatch Extension), go to the General tab, and change
the Team to your developer account in the Identity section. Do this for the
ResearchKit project file and target as well.

5. Change the bundle identifiers in the following locations:

a. myNeuro > Targets > myNeuro > General > Bundle Identifier
com.SJM.myNeuro.[YOURNAME]

b. myNeuro > Targets > neuroWatch > General > Bundle Identifier
com.SIM.myNeuro.[YOURNAME].watchkitapp

c. myNeuro > Targets > neuroWatch Extension > General > Bundle Identifier
com.SIM.myNeuro.[YOURNAME].watchkitapp.watchkitextension

d. myNeuro > neuroWatch > Info.plist > WKCompanionAppBundleldentifier
com.SJM.myNeuro.[YOURNAME]

e. myNeuro > neuroWatch Extension> Info.plist > NSExtension >
NSExtensionAttributes > WKAppBundleldentifier
com.SJM.myNeuro.[YOURNAME].watchkitapp

6. Plug in your device and select it as the build destination by going to Product >
Destination and selecting your device.

7. Ensure the myNeuro app is selected if using the app without an Apple Watch. Select
the neuroWatch app if an Apple Watch is being used.

8. Select the myNeuro project file in the left panel and click the “Fix Issue” button by
the alert under the Team tab. This will generate a code signing signature for the app.

9. Click the “Run” button to build and install the app. This will run the app in debug
mode while the device is plugged in. Stop debug mode by clicking the stop button
before unplugging the device.
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Method 2: Install using the “.ipa” application file
NOTE: The device ID must be entered on the Apple Developer account linked to the
myNeuro application at the application build time. Failing to do so will prevent the app from
installing on the device. Instructions for finding the device ID can be found here.

The application can be downloaded here by choosing the most recent myNeuro app or
neuroWatch app and downloading the “.ipa” application file. Once downloaded, follow these
instructions to install the application:

1.

2.
3.
4

Plug in a compatible device into the Apple Computer with Xcode installed.

When prompted on the device to trust the computer, choose “Trust”.

Open Xcode and ensure your device has been connected.

With Xcode open, go to Window > Devices. Ensure your connected device is listed
on the left panel.

Select the desired device. Under the Installed Applications section, click the “+”
symbol and open the “.ipa” application file.

Xcode will validate and install the application on the device.
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3.0 USING THE APP

3.1 Starting the Application

myNeuro app installed on
iPhone. Press the app icon to
start the app.

myNeuro splash screen after
app has started. App
contents are loading.

59

Welcome 0 the
myNuero Rosearcth

Study

Starting page of the app.
Slider style pages with
information about the app
and a Join Study button.



3.2 Joining the Study

Eligibility screen to
determine if the user
meets the inclusion
criteria.

Data Gathering
information during the
visual consent process.

Study survey
information during the
visual consent process.

Screen displayed if user
meets eligibility
requirements. Button

to continue on to study.

o

Privacy information
during the visual
consent process.

Study task information
during the visual
consent process.

Screen displayed if user
does not meet eligibility
requirements.

Data use information
during the visual
consent process.

Withdrawing
information during the
visual consent process.
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Welcome information
during the visual
consent process.

Time commitment
information during the
visual consent process.

Review consent form.
User must agree to the
consent form to
participate.



- - E—-
Vo ad e W P (it R Ao
e vy

Prompt displayed to
confirm user agrees to
consent form.

Screen displayed if user
disagrees to the
consent form.

Demographic PD Characteristics
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Gather patient
Parkinson’s Disease
characteristics. (top)

Gather patient
demographic information.

L 2 3
4 s L
7 8 9

0 @

If device has TouchID
capabilities, gather a
fingerprint.

Enter passcode to protect
patient information.
Passcode will need to be
entered to open the app.

Consent

v T4 [ et Na

Povt Nane Tew

(T

Gather user’s full name
after they’ve agreed to
the consent form.

0000 Verizon ® a:25PM 73 sex a0y

< Cancel

Anticholinergics
MAO-B Inhibitors
COMT Inhibitors

None

DO YOU HAVE A DEEP BRAIN STIMULATION (D8S)
SYSTEM IMPLANTED?

Yes v

No

Gather patient
Parkinson’s Disease
characteristics.

Welcome aboard

Nk o S oG T Wy

Patient has completed
the consent review
process.
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Signature

Paats G Arg yos ge o T Ve

Gather user’s signature
to confirm they’ve
reviewed the consent
form.
T T T
< Cancel
DBS Configuration

Enter the lead configurations below. For
example, if using leads 1, 3,5, and 8, enter
1358'

LEFT DBS LEAD CONFIGURATION
Anodes(+) 1458
Cathodes(-) 1678

RIGHT DBS LEAD CONFIGURATION
Anodes(+) 167

Cathodes(-)

Gather DBS
configuration info if
DBS implanted.



3.3 Patient Profile

®e000 Verizon = 1:21 PM 7 3 94% )
Profile
1 Test Name
Backup JSON Files
2 Upload Data } 4
33— ]  Backupwith DynamoDB
— 5
myNeuro Research Study 6
Age 50
Gender Male
Ethnicity White
. . — 7
PD Diagnosis Date 12/5/04
Medications Carbidopa/Levodopa
DBS Parameter 100 Hz

Profile

1. Patient full name: Displays the full name of the patient.

2. Upload Data button: Uploads the Core Data data store to a secure Amazon S3 bucket.
Additional data is uploaded if the switches are on (see 4 and 5).

3. Progress Bar: Shows the status of the current data upload.

4. Backup JSON Files switch: When on, data uploads will include individual JSON files
from task results (i.e. accelerometer, device motion, etc.)

5. Backup with DynamoDB switch: When on, data uploads will also upload Core Data table
entries to a secure Amazon DynamoDB database. Note that this will require much longer
to complete the upload and the upload status will not be reflected by the progress bar.

6. Leave Study button: Withdraws the current participant from the study. Any data gathered
will remain stored on the device. Use this to reset the study for a new patient.

7. Patient Demographic information and PD Characteristics: Displayed the demographic
information and PD Characteristics gathered during the onboarding process.
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3.4 Activities

1. Questionnaire: Gathers information regarding the patient’s Parkinson’s Disease

0000 Verizon = 1:21 PM

Activities

Questionnaire
Questionnaire

Tremor
Test Tremor

Bradykinesia
Test Bradykinesia

Gait

Test gait and balance

Tremor (Watch)
Test Tremor (Apple Watch)

Bradykinesia (Watch)
Test Bradykinesia (Apple Watch)

(o

Activities

7 3 94% Em

symptoms and the impact they have on their daily life.

2. Tremor: User performs several motions tasks relating to resting, kinetic, and postural
tremor.

Bradykinesia: User performs a tapping task relating to bradykinesia symptoms.

Gait: User performs a gait and balance task relating to gait symptoms.

5. Tremor (Watch): User performs several motion tasks relating to resting, kinetic and

W

postural tremor using the Apple Watch.

6. Bradykinesia: User performs a tapping task relating to bradykinesia symptoms on the
Apple Watch.
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3.4.1 Questionnaire
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3.4.2 Tremor
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3.4.3 Bradykinesia

g tota

Tapping Speed

Bradykinesia task
introduction screen.

Act

Completion screen.

o 2ot d

Tapping Speed

Bradykinesia task
description screen.
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< Step3ofa Cancel

Tap the buttons as
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Start tapping to begin
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< Step3ofd Cancel

Tap the buttons as
consistently as you
can using two fingers.
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Gait and balance task
introduction screen.

- " R

g Sor)

Turn around, and walk

back

ore you

started

Step 2

Gait and Balance task
description screen.

still for five

Step 3
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Countdown

Completion screen.
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3.4.5 Tremor (Watch)

Tremor Watch task
introduction screen.

Step 3

Step 7

Tremor Watch task Step 1
description screen.

Step 4 Step 5

Step 8 Step 9
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3.4.6 Bradykinesia (Watch)

§ - . " - EERRT . " - EERRT

Bradykinesia Watch Bradykinesia Watch Watch connect screen Waiting for task to
task introduction task description. finish screen.
screen.

Completion screen.
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3.5 Analysis (Under Development)

Notice

Analysis does not currently include
accelerometer/device motion
calculations.

OK
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4.0 ACCESSING DATA

4.1 Amazon Web Services (AWS)

Data from the study may be uploaded to AWS (Amazon Web Services) storage either via files to
an S3 bucket or individual table rows to a DynamoDB database. After pressing the Upload Data
button in the Profile tab, the Core Data data store (SQLite database) is uploaded to the AWS S3
bucket. Switches in the Profile tab also enable/disable individual JSON files from task results and
DynamoDB backing in addition to the Core Data data store upload. Any uploaded data can be

accessed by following these instructions:

1. Login to the AWS console (https://aws.amazon.com/console/) using the AWS account.
'. ® AWS Management Console X | Charles |
& C ([ 8 ntpsijaws.amazon.com/console] %920 Mm@ :

Products ¥  Solutions

Pricing  Software  More ~ English ~

mazon
webservices

eo0e

PRODUCTS & SEAVCES @ Amazon Web Services SignIn X

My Account ~

¢« Ccnla han return.

ws.amazon.com%2Foau

AWS Console
AWS Gonsale Mohile Ann

webservices

Sign In or Create an AWS Account
What is your email (phone for mobile accounts)?

E-mail or mobile number:

Iam anew user.

© Iam areturning user
and my password is:

( sign in using our secure server )

Forgot your password?

Amazon S3:
1. On the top menu bar, navigate to Services > S3

eoce AWS Management Console X

¢«  Ccnla aws.amazon. gion=us-east-1#
B  AWS v Services ~
History All AWS Services > 4 APIGateway & DynamoDB

Console Home Compute + AppStream b ec2

i s3 Storage & Content Delivery @ AWS loT [ EC2 Container Service
2 1am Database = Certificate Manager J' Elastic Beanstalk
fé) Cognito Networking @ CloudFormation & Elastic File System
€ DynamoDB Developer Tools = CloudFront & Elastic Transcoder

2. Click the “myneuro” bucket
:

o $3 Management Console

cC e

AWS v

x

aws.amazon.com/’

2region=us-east-1#
7]

All Buckets (1)

Services v

Name

ponse._type%3Dc

Run Production Docker Workloads witfs

Amazon EC2
Container
Service

| cnartes |

i oOrMmMo:

Charles v N. Virginia v Support v

@ OpsWorks
@ ros

Wit Redshift

4 Route 53

[ ]e—

@ Service Catalog

| cnartes |

s oOr Mo :

Charles v Global v Support v

None Properties  Transfers

I

S -—

‘ Q $3 Console

3. Core Data data stored are uploaded to a folder titled with the
Select the folder containing the file you want to download to
click the file to download.

71

date and time of the upload.
your computer. Then double



eoe $3 Management Console X | craries

&« C ()| & https://console.aws.amazon.com/s3/home?region=us-east-1#&bucket=myneuro&prefix 44 OlrMmMao :
W§ AWS v  Services v Charles v Global v Support +
m Create Folder  Actions v Q None Properties  Transfers (<l

All Buckets / myneuro
Name Storage Class Size Last Modified

B 09-14-2016_1-28PM

i 09-14-2016_9-36AM

$3 Management Console x Charles
€ C 0| a I aws.amazon.com/s3/ho gion=us-east-1#&bucket refix=09-14-2016_9-36AM/ * 0o ac}

NF  AWS v  Services v E Charles~  Global v Support v
m Create Folder  Actions v Q None Properties ~ Transfers <l
All Buckets / myneuro / 09-14-2016_9-36AM

Name Storage Class Size Last Modified
[ myNeuro.gb Standard 2MB Wed Sep 14 09:37:32 GMT-700 2016

NOTE: “.db” files can be opened using the SQLiteStudio program downloadable for free from
http://sqlitestudio.pl/. This program can also export individual table as other file formats
(i.e. CSV) for processing with data analysis programs.

4.2 Offline

1. Plug in the device and open Xcode.

2. In the top menu bar, go to Window >
Devices = 2

3. Select the device on the left panel :

4. In the “Installed Apps” section, select the
myNeuro application

5. Click the gear icon below and choose
“Download container”. Choose a location to save. This will save the app data to a
“xcappdata” file.

6. A finder window containing the file should open automatically. If not, navigate to the
folder containing the container.

7. Right click the file and choose “Show Package Contents”.

8. The “.db” file containing the results is located in the AppData/Documents folder. Open
this file using SQLite Studio

& xcode Fle Edit View Find Navigate Editor Product Debug Source Control [KUTEISTN Helo
M

Documentation and AP| Reference 00
Welcome to Xcode 031

. ‘Organizer
Projects
Bring Al to Front

2 =[o = % A O

[l _test.xcappdata

Open
Open With >

k. ackage Contents

L] AppData » || Documents » [W 1E222FE8-..9259COF37 »
AppDatalnfo.plist 9 Library > 7] 672A92EA-...4441D028 »
B tmp » [ D6590E9E-..D51983C3 »

7 EC8118F0-...7F620E013 »

R myNeuro.db N
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4.3 SQLiteStudio

In order to access the “.db” files containing the data gathered through the app, SQLiteStudio is a
great resource. This program is available for free from http://sqlitestudio.pl/ . After opening the
“.db” files in SQLiteStudio, we can export the data in other formats like .csv for processing in
data analysis programs like MatLab.

Open SQLiteStudio

In the top menu bar, go to Database > Add a database. Select “SQLite 3” for the database

type. Click the folder icon to browse for the myNuero.db file. You may need to

copy/paste the “.db” file from within the “.xcappdata” package contents to an outside

folder to navigate to the file.

Select the myNeuro.db file and press Ok.

4. Double click on the database to connect to it or use the connect button in the upper left of
the window.

5. Data tables are displayed. Use the “Data” tab to see the contents of the tables.

To export data, right click on a table and select “Export the table”.

7. Navigate through the export settings changing them as you’d like.

N —

98]

e

& LB A 2
e
& iCloud.
A Applcat.
£ saLiteStudio (3.1.0)
B3 Google-. ¥ & B B B B OEBGB & ¢ %« & @ & BB @BiO® K »i® »
B Gitrub [5) Datavases e0e® | ZTAPPINGSAMPLE (myNeuro)
- aFilter by name structure [JEEEM Constraints Indexes  Triggers DL
v & myNeuro (saLte 3) [ view 2R
v Tables (13)
» [T ZMETADATA B UGB OO0 B0 @ i 3 & [itrdata &~ Total rows loaded: 152
» [ Z MODELCACHE
» [ ZPRIMARYKEY ZISBACKED  ZPK  ZUSER.ID ZDURATION ZL0CX ZLOCY  ZTIMESTAMP  ZBUTTON.D
» [ ZACCELSAMPLE 7 [ 0 1] 0.08330566666700179 127 | 5165  1.984462416667157 | left
» | ZBRADYANALYSIS 7 0 0 1] 006667587499830697 | 2705 | 5125 | 2184712958334785 | right
» [ ZGAITANALYSIS 7 3 0 1] 0.06672204166534357 | 124 511 2.351246125001126 | left
> [ ZMOTIONSAMPLE 73 [ ) 1] 0.0833989583334187 | 266 5095 | 2.534643666667762 | right
> [EJ ZPARTICIPANT 4 0 0 1/ 0.08656775000010384 | 119 5185  2.701539166666407 | left
5‘”‘"‘5 5 0 0 1 0.06650237500025483 | 264 | 5175 | 2.88471545833454 | right
) TASKRESULT [ Comtoambie 7 0.0502004166677125 | 1235 528 3.051604333333671  left
» [ ZTREMORANALYSIS 1 Ecit the table 003338108333264245 2615 511 3.268527708334659  right
» [ ZWALKINGSAMPLE | 14 Delete the table 0.0665077083340293 | 1255 521  3.418732916667068  left
i Views 0.04974266666613403 | 2795 | 5035  3602181708334683  right
(i Add a column 006661687499945401 | 146.5 | 5075 | 3.785385916668019 | left
. 2 Create an index 01169612083340326 | 288 607  39185674583332  right
[ ] [ # Database i Create a trigger 009986029166793742 138 | 56155 | 4102300958333217 | left
7 Generate query for table >l
Database type i Import into the table b ss
i A &/ Populate table
SQLite 3 ) Create similar table
) Reset autoincrement sequence
= i Erase table data
File
I Database >
[[7) ZTAPPINGSAMPLE (myNeuro) | . .
lers/caylward/DownIoads/test/myNeuro.db| Q= - -
eoe MG (] B test Qv Search Sheet at
Name (on the list) Home Insert Pagelayout Formulas Data  Review View ©- v
Al . Z.PK v
myNeuro Generate = #
A B c D E F G H | J K L M
. 1 [zpx 2 ent z_0pT 0 2ISBACKED  ZPK ZUSERID  ZDURATION ZLOC X  2LOCY  ZTIMESTAMFZBUTTON_ID
Options 2 1 7 1 2 [) [) 1 0066704 130 504.5 0 left
3 2 7 1 2 [) [) 1 0.06645321 268 523.5 021676987 right
Permanent (keep it in configuration) 4 3 7 1 2 [ [ 1 0.06691617 1225 527 0.41670154 left
5 4 7 1 2 [ [ 1 00667445 254 500 0.61703896 right
6 5 7 1 2 [ [ 1 0.08320617 1315 516 0.80057483 left
7 6 7 1 2 [ [) 1 0.08331187 266.5 497.5 1.00071533 right
Test connection Cancel m 8 7 7 1 2 0 0 1 0.08340037 127 508 1.18397479 left
LS 9 8 7 1 2 [ [) 1 0.06682396 255 503.5 140044733 right
10 9 7 1 2 [ [ 1 0.06701175 123 515.5 158383267 left
1 10 7 1 2 [ [ 1 0.08332483 260.5 507.5 175106629 right
12 1 7 1 2 [ [ 1 0.08325933 1245 510 191774629 left
13 12 7 1 2 [ [) 1 0.08330183 256.5 516 2.10113425 right
14 13 7 1 2 0 ) 1 0.06651471 123 512 2.2845665 left
4 » test +
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